Module 1: The Microsoft Windows NT 4.0 Environment

Features of NT 4 Workstation

Internet Explorer

Personal Web Services

Security


Desktop Services

Limited licensing

Messaging Services

Stability and Performance benefits (compared to W95/98)

multiprocessor support  (2 cpus)

not plug and play

requires hardware profiles for docking station connections

maximum of 10 users permitted to log on (this is not physically enforced)

does not support network logon, but does provide sharing and security services

For adequate security protection, the latest NT service packs should be installed

Although NT Workstation machines can be used as servers, they lack some sophisticated features of NT 4 Server

Additional Features of NT 4 Server

Directory Services (Domains vs. Workgroups ) 
Microsoft Internet Information Server

Administrative Wizards



Network Services (DHCP,  WINS, DNS, FTP, Mac support)

256 inbound connections through RAS

Fault Tolerance (hard disk mirroring)

Similarities and differences compared to Windows 95/98

They have the same general desktop interface:

The original version ships with Internet Explorer v. 2.  May be upgraded by Service packs downloaded from Microsoft website.  Later CD ships with Internet Explorer 3 and 4 included.   Current service patch is SP6a.   Active Desktop can be added along with Internet Explorer 4 or 5.

No DOS underneath the NT GUI

     Graphic interface is part of the system kernel.  The DOS command prompt within the OS is emulated.

     What can you do if Windows NT won’t boot?

     How can you get command-line access if the GUI won’t load?

All programs (both Windows and DOS) can run in separate, protected memory address spaces.

No Plug and Play

     Installing new devices and fine-tuning performance is done through different Control Panel

     Applications than under Windows 98.

NT has a slightly different Start Menu

               Divided into common program groups and groups specific to each user.

Module 2: Installing Windows NT

(see also XSH_05 to 08.DOC in the \help directory on your Windows NT Installation disk)

Microsoft’s system requirements:  486 DX33, 16MB RAM, 150 MB disk space

Real world:  at least 32MB of RAM, 64 better, 350MB of disk space.

Before installing Windows NT check hardware compatibility from booklet enclosed in the box or Hardware Compatibility database on Microsoft website.   Http://www.microsoft.com/hcl/default.asp

In order to be stable, Windows NT  should be upgraded to at least Service Pack 3 immediately after installation from original CD.  Service Pack 7 is the latest.

To install Windows NT Workstation or Server, insert startup diskette 1 in drive A or boot from Windows NT CD if your computer supports it.   The installation files are in the i386 directory on the CD.  The setup command is

I386\winnt.exe   (or winnt32.exe from within the NT interface.)

In general, if you’re going to install on a FAT disk partition, it’s a good idea to copy the i386 directory to a local hard disk directory and run it from there.

Windows NT does not support FAT32.  It supports the older FAT16 partitions and its own proprietary file system called NTFS.   (NTFS partitions are invisible to DOS and Windows 95/98.)

During the installation process, you’re given a choice to reformat your hard disk, set up an NTFS partition or install on an existing FAT partition.

Windows NT Setup loads its own drivers for hard disks and CD-ROM drives, but also gives you an option to use a third-party driver during setup.

Loading the Software

If you have an CDROM supported by NT you can load the software direcdy from the CDROM To create the install floppies: Get 3 formatted floppies, from a DOS prompt run D:\1386\WJNNT .EXE 10 Reboot your system with Disk I in the A: drive

If no NT compatible CDROM is available; copy the appropriate directory to your hard drive and run the install program from there.

	System:
	Install Directory: 

	Intel x86
	\1386

	MIPS
	\MIPS

	DEC Alpha
	\ALPHA

	Power PC
	\PPC


If you are upgrading the NT server from 3.51 to 4.0 you may use WINNT32.EXE

If you are installing a fresh version of NT 4.0 on an Intel system use WINNT.EXE

If you are installing a fresh version of NT 4.0 on an RISC system (MIPS, Alpha or Power PC) use

SETUPLDR

During the Setup process you will be prompted for several items of information:

· Formatting of the installation partition as FAT or NTFS Adapters, video, Disk, Network

· If your IDE hard drive is not detected during the auto~detection phase of the installation, press the S key to manually select the IDE driver. It is located under the SCSI controllers, ATAPI 1.2 is the proper choice for an IDE hard drive.

If the installation process asks for installation disk 4 the NT Installer did not properly identify your CDROM. You must abort the install process, find the correct CDROM driver, or copy the install directory to your hard drive and start the install process over.

Installation Steps 

Blue screen installation

Setup/repair screen
Basic hardware detection (disk drives & controllers)

License agreement

Component confirmation

Blue screen partitioning, select installation drive, file system

Disk integrity check/ formatting/file copying

[Reboot]

Setup Options

Enter name.and organization
CD Key

 Computer name (NETBIOS name)

Password for administrator account

Create Emergency Repair Disk

Select components (Typical, compact, custom)

Choose Network Connection  (None, RAS or Network Adapter)
Detect Network card

Networking protocols (NETBEUI, TCP/IP, NWLink (IPXISPX))

Detect DHCP Server

Binding protocols to adapters

Join Workgroup or Domain

Copies files, date/time, IE configuration

Video Adapter Detection/Configuration

Network Architecture -- Review

Required components for a network connection


Client


Network Adapter


Protocol



NETBEUI



NWLink  (IPX/SPX)

           

TCP/IP

See  http://userwww.sfsu.edu/~lennyb/edsite/chap25_1.htm)
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Windows NT Administrative Tools group

Administrative Wizards  provide guided walkthroughs of basic tasks (these can also be accomplished directly through individual administrative applications).

Disk Administrator lets you control disk partition defaults – replaces MS-DOS FDISK

Event Viewer (provides diagnostics on features that don’t start up properly)

License Manager (records license information for OS and applications)

Remote Access Administrator   (controls Remote access privileges of clients)

Server Manager  (allows you to manage existing network shares and see who’s using them)

User Manager  (core application for creating and administering user accounts.  If the computer is a Primary domain controller, this is accomplished through the User Manager for Domains.)

Windows NT Diagnostics  (provides some limited troubleshooting features – a less powerful version of Windows Device Manager).

Domains vs. Workgroups

A workgroup is a collection of computers linked informally into a physical network to share software and hardware resources.   Workgroups usually follow a peer-to-peer network architecture

A domain is a collection of  computers serving users with common access needs from a centralized server. Domains usually follow a client-server network architecture

In a workgroup each server maintains an individual user account database

in a Domain, there is a common user account database.

A Windows NT 4 domain must include a Primary Domain Controller in addition to client workstations (NT4, W95/98 or other operating systems).  The domain  may also include a backup domain controller and member NT servers.,

Logging on to a Windows NT Server

Press Ctrl+Alt+Del     Why?

Networking

Protocols:TCP/IP, NETBEUI, IPX/SPX

Configuring Networking - Open Settings, open Control Panel, open Network, the Network Setup window

has tabs for Adapters, Protocols, Services, Identification and Bindings

Adapters - Select the type of network adapter and the IRQ and I/O Port address

Protocols - Only load the protocols necessary, additional protocols add overhead to the system

NETBEUI - Used for Microsoft clients on the LAN, good for print and file sharing

IPX/SPX - Used in existing Novell environments and where there is heavy client/server traffic

TCP/IP - Used in Intranets and the Internet, also good for printing, file sharing, and client/server

applications

Under the configure button there are several fields that must be filled out correctly for TCP/IP to fimction

IP Address - The IP address of this interface. Usually assigned by the network administrator

Subnet Mask - The number of bits of address space used for network addressing

Default Gateway - The IP address of the router on the LAN

Domain Name Servers - The IP addresses of DNS servers used to resolve host names to IP addresses

WINS - The IP address of the Windows Internet Naming Service server used to resolve local host' names to

IP addresses. This can he used when local hosts do not have static IP addresses

Routing Tab - Allows you to use the NT server to route packets between different interfaces

One of the more popular uses of this ftmction is to route IP packets between an Asynchronous interface

(running RAS) and an Ethernet interface

Network Services - NT Server has several built in services available

Computer Browser - Allows the NT Server to see a list of computers on the network

NetBIOS Interface - Support for older NetBIOS clients

Server Allows the NT Server to perform server ftmctions

Workstation - Allows the NT Server to perform workstation fanctions

BOOTp Relay Agent - The original way for a server to dynamically assign clients an IP address

FTP Server - Provides a file server using the File Transfer Protocol

Gateway (and Client) Services for Netware - Provides File Sharing, Printing, and other Novell services to

Novell clients

Microsoft DHCP Server - The Dynamic Host Configuration Protocol allows the NT Server to assign

network information to clients such as IP addresses and gateways

Microsoft TCP/IP Printing - Provides print services via UNIX style LPR/LPD

Network Monitor Agent - Allows the NT Server to perform basic network monitoring ftmctions

Network Monitor Tools and Agent Allows the NT Server to monitor the network via the Simple Network

Management Protocol (SNMP)

Remote Access Service - Allows the Server to permit dial in connections

Remoteboot Service - Allows the NT Server to be used as a boot drive for remote clients

RIP for Internet Protocol - Allows the NT Server to route IP packets between LAN segments

RIP for NWLink IPXISPX Compatible Transport - Allows the NT Server to determine routes for IPX/SPX

traffic

RPC Configuration - Allows the NT Server to execute Remote Procedure Calls bn other UNIX systems

RPC Support for Banyan - Allows the NT Server to execute Remote Procedure Calls on other systems

using Banyan networks

SAP Agent - Allows the NT Server to send Novell Service Advertising Protocol messages

Services for Macintosh - Allows the NT Server to provide print and file services to clients

Simple TCP/IP Services - Provides basic services to the NT Server. Other TCP/IP services require this before they can start

SNMP Services - Loads the SNMP client for remote computers to monitor the NT Server performance statistics

Windows Internet Name Services - Allows the NT Server to resolve local host names to IP addresses, necessary in a dynamically assigned IP environment

Identification - This is the field where the Computer Name and Workgroup are identified

Bindings - Bindings are the connection between the interfaces and the protocols / services

When multiple interfaces are used in an NT Server (such as an Ethernet card and RAS) the protocols and services are bound individually to each interface

RAS - Remote Access Service is used to allow dial in client to connect to the NT Server, or the LAN the server is on if routing is enabled. The bindings between the protocols and the interface are selected in the Network Setup panel, but the modem set up is configured under the Modem Option of the Control Panel and the modem connections and privileges are configured under Remote Access Administration from the Startup menu.

Sharing Files and Printers

File Shares

Creating Shares using the Wizard - Open Programs, open Administrative Tools, open Administrative

Wizards, open Managing File and Folder Access, A setup wizard will ask for the following information to

set up Shared Volumes:

Where the shared folder and files reside - On this computer, or on another computer

Select the path to the folder to be shared

Set the file access permissions

Select a name for the shared folder and what type of clients have access to it

Creating Shares using the Explorer/File Manager - Use the Explorer or My Computer to locate the directory to be shared, select the directory, right click the directory and select the sharing menu, enter the name to the will be called, the number of users that can access the share, click on the permissions button, use the Add and Remove buttons accordingly to grant users access to the share and set the file permissions to Full Control, Read, Change, or No Access

Sharing Printers

NT Server can manage locally attached printers as well as printers attached to other computers. The advantages of allowing NT Server manage printers attached to other printers are access control and the print queue resides on the server, not the hosting computer.

-Configuring a Printer - Open the Control Panel Settings menu, select the Printers option, click on the Add Printer icon. A set-up wizard will guide you through the configuration. After setting up the printer the wizard settings may be reoptioned and other settings such as Job Scheduling, and Security may be configured by selecting printer properties from the Control Panel, Printers screen

Sharing Printers - Open Settings, select Printers, choose the File menu, choose the Properties menu, under the Sharing Tab set the Share Name, Under the Security Tab define who has access to the printer.

User Administration

User Manager

The User Manager (or User Manager for Domains) Tool allows adding of a user and setting the administrative properties of a user on an NT Server, and Workstation in a Workgroup or a Workstation in a Domain. New users may be added in either the User Manager or the Wizards.

Adding a New User - Open Programs, open Administrative Tools, open User Manager, choose User menu, choose New User, enter the User Name, Full Name, Discription, Password, click OK.

Group Properties - The Groups function in the User manager allows adding or modif'ying groups. To add a group, from the User menu, select New Local Group (to the domain) or New Global Group. To modify an existing Group, select the Group and choose properties from the User menu.

User Properties - The User Properties window allows the adding or modification of logon properties of users. This is where user accounts can be disabled. The Account Lockout occurs after repeated logon failures, with no automatic reset tirne.

Group Memberships - On the bottom of the Users Properties page is the Groups button. The Gtoup

Membership window allows the setting of memberships of users in groups.

User Environment Profile - The Profile button on the Users Properties page allows the setting of the User

Profile (edited by the User Profile Editor), Logon Script and the Home Directory Path.

Logon Hours - The Hours button on the Users Properties page allows the setting of allowable hours the user can connect to the server. The user will not be logged out of the server if logged on before the blackout period (if specified).

Logon Workstations - The Logon to button on the Users Properties page allows Itmiting which workstations a user may logon to.

Account Information - The Account button on the Users Properties page allows setting when the users account expires and if the account is Local or Global.

Policies

The next set of configurations are for the entire NT Server, not configuration of individual users, they are all reached from the Policy menu of the User Manager:

Account Policies - This is where the settings for Password Expiration, Mniiimum Password Age, Minrtnum Password Length, Password Uniqueness, and Account Lockout on failed logon attempts are set.

User Rights Policy - This window allows setting permissions for groups to perform a number of sensitive fianctions such as shutting down the system.
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Auditing - From the Auditing Policy window auditing may be enabled to track a variety of system events.

Trust Relationships - A Domain may enter into a trust relationship with other Domains, where they will honor global user accounts on the other Domain's Server. Trust accounts are one-way, each Domain must configure their trust for each other to enable a two way trust arrangement.

Windows NT Control Panel

*=important

Add/Remove Programs – similar to Windows 98 

Console – sets MS-DOS options

*Devices – presents list of installed hardware devices, allowing you to start and stop on a case-by-case basis

Dial-Up Monitor – dial up network diagnostics

Display – similar to Windows 98

Internet – similar to Windows 98

*Network – controls hardware/software network settings.  Much more complex than Windows 98

         Important services: 


 RAS – remote access service to let users dial in to network via modem

 
IIS   Internet Information Server – web server

  
DHCP – Dynamic Host Control Protocol – automatically assigns IP addresses to client machines


WINS – Windows Internet Naming Service – matches IP numerical addresses with NETBIOS
              names  (proprietary Microsoft service)


DNS     Domain Name Services – matches IP numerical addresses with computer names
                           this is a more general naming service that complies with UNIX and other platform
                           standards

SCSI Adapters – controls ordinary ATAPI (IDE) CD-ROM devices and tape backup as well as SCSI hard disks

Server – provides status on currently shared folders and users logged into the domain

*Services – lists all currently running Windows NT services, allowing you to start and stop them manually 
                   or automatically.
 

*System – controls Windows NT startup options.  Controls paging(swap) file and offers some diagnostic
                   information. 

Get more help with Windows NT

Insert Windows NT Server CD in CD-ROM drive.

Choose \SUPPORT\BOOK folder and double-click Server icon.

Managing Shares

The Server Manager can create, modify and remove shares on local and remote NT Servers and NT

Workstations. Open the Server Manager, select the computer, in the Computer menu choose Shared

Directories, from this windows New Shares may be created, Properties can modify an existing share and

Stop Sharing will remove an existing share.

Before Removing Shares - Removing the share immediately stops sharing, check to see if anyone is using the share before clicking the Stop Sharing button, or user data may be lost.

Resource Accounting

The Server Manager can be used to display the users connected, available shares and shares in use on local

and remote NT Servers and NT Workstations.

Open the Server Manger, select a computer and choose Properties. The Properties window contains:

Usage surtunary: The number of sessions are the numbers of users connected to the computer.

Users:
Displays which users are connected to the computer and what resources they are using.

Shares:
Displays which shares are available and who is using them on the computer.

In Use: Displays the resources that are currendy in use on the computer

Directory Replicator Service

The Directory Replicator Serve copies directories from a NT Server to another NT Server or NT Workstation. This service was intended to copy login scripts to other domain controllers. To have it work, the sending computer must have the Export server configured and the receiving computer must have the Import Server configured from the Server Manager Replication button.

Alerts

Alerts are used to notify administrators of the occurrence of a serious NT Server problem. To receive alerts the Alert and Messenger Service must be running. On NT Servers this is automatically started by default.

Configuring the Alert Service - Open the Server Manager, double click the computer name to select the Properties, click the Alerts button, enter the Computer or Username and click Add button, click the OK button.

Event Viewer

The Event Viewer is used to view event logs from the System Log, Application Log and the Security Log. The log files should be reviewed frequently to determine if there are system errors or security breaches that will effect the server performance. An NT Server creates a lot of events, Filtering mihimizes the number of events needed to be searched through. To prevent the log files from growing indefinitely, the events can be cleared, overwritten, or archived.

Viewing Events - Open tlie Event Viewer, select the log to be viewed, double click on the event to see the details.

Filtering Events - Open the Event Viewer, choose the View menu, Filter Events, in the Filter window specify the date and time range and types of events to be seen, click OK Once a filter has been applied the word Filtered" appears in the tide bar of the Event Viewer.

Log Settings - Open the Event Viewer, choose Log menu, Log Settings, from the Log Settings window the events can be cleared (erased), or overwritten after a specified number of days. To Archive the log:

Open the Event Viewer, choose the Log Menu, choose the Log Type, choose Save As, enter the type of file to save the log as, click OK Comma separated text may be read by Excel and most other databases.

Audit Policy - An audit policy should be planned for every server. This policy will include the frequency of log reviews (usually weekly), how long event information should be retained, where old events are to be archived (if at all), and who is responsible for these administrative tasks.

Repair Disk Utility

The Repair Disk Utility is used to create and update the Emergency Repair Disk~ This disk contains important files for restoring the NT Server. Before makiug any system changes run the Repair Disk Utility to backup the Registry. Keep this disk with the 3 boot disks created to install the server from CDROM.

Installing the Repair Disk Utility - Right click the Start button, choose Open All Users, double click the

Programs icon, double click the Administrative Tools icon, choose the File menu, choose New, choose

Shortcut, type RDISK at the command line prompt, click the Next button, click Finish.
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